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Documenting Heritage Languages:
Methodological Aspects
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patrimoine en partage" under the directorship of France Martineau and supported through a Major Collaborative
Research Initiative grant from the Social Sciences and Humanities Research Council of Canada. The research
was supported by SSHRC SRG 410-2009-2330 to Nagy.

Long-range questions

SOCIOLINGUISTIC:
* How are social factors relevant ?

* Do the same (types of) speakers lead
changes in both/all their languages ? (i.e.,
are the same factors relevant in majority and
minority languages?)

* Or do speakers choose to use one
language or the other for this social ., 2000
“work” ?
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Conditions necessary to establish the existence of
contact-induced change

Paraphrased from Thomason (2001:93-94):

1. situate the proposed change with respect to its host linguistic system
2. Identify a presumed source of the change

3. Locate structural features shared by the source and recipient languages

Need to find several structural features that have been influenced!
(Nichols 2008:361)

4. Prove that the proposed interference features were not present in the pre-
contact variety

5. Prove that the proposed interference features were present in the source
variety prior to contact

6. Rule out (or situate) internal motivations

7. Sociolinguists: Replace “features” with “stochastic patterns of variables”
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Long-range questions

LINGUISTIC:

» Are cross-linguistic generalizations
possible about the types of features,
structures, rules or constraints that are
borrowed earlier and more often ?

* If so, what ? Nagy 2009
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Problem
Studies of contact-induced language
variation vary widely
in terms of methods & contexts,
inhibiting generalizable findings

Solution
Consistent methods and context,
while varying pairs of languages in contact
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Generation

30 Dec. 2007

Speaker of...

Generation

Ukrainian

1%t: born in/near Lviv;
moved to Toronto after age 18;
in Toronto 20+ years

2nd: horn in Toronto
(or came from homeland before age 6);
parents qualify as 1st generation

3rd: horn in Toronto;
parents qualify as 2nd generation

Italian

1st: born in Calabria...

Russian

1st: born in Moscow or St. Petersburg...
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Contrasting demographics

Language MT speakers Ethnic Origin Est. Came from
(2006 Census) (2006 Census) inTO
Italian 194,000 466,000 1908 Calabria
Cantonese 170,000 537,000 1951 Hong Kong
(Polish 80,095 207,495 1911 Eastern Poland)
Russian 66,000 58,505 1916 St. Petersburg, Moscow
Korean 49,000 55,000 1967 Seoul
Ukrainian 27,000 122,000 1913 Lviv
(Hungarian 20,190 53,210 1880 Budapest)
Faetar <100? <5007 1950 Faeto, Celle di St. Vito

11/8/12

www40.statcan.ca/l01/cst01/demo12c-eng.htm
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Participant criteria

(Apulia Italy)

(Self-defined) fluent speaker of...
Cantonese
Faetar
Korean
Italian
Russian
Ukrainian
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Age group
Languages Generation Age
1t: born in homeland; 60+
moved to Toronto after age 18;
in Toronto 20+ years 39-59
60+
2": born in Toronto 40-59
(or came from homeland < age 6);
o arents qualify as 1st generation 21-39
Ukrainian P uatly 9
<21
60+
3: born in Toronto; 40-59
parents qualify as 2nd generation 21-39
<21
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Languages Generation Age Sex
2 females
« . X 60+
Ukrainian 1= born in homeland; 2 males
moved to Toronto after age
18 39-59 2 females
2 males
Italian .o
Russian .o
Korean .o
Cantonese | “ “
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Data collection methods

1. Sociolinguistic interview (~1 hour)

2. Ethnic Orientation Questionnaire
3. Picture Description Task

All conversations guided and
recorded by native speakers
in the heritage language
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For every variable, 3 kinds of compariso

KEY
O HLVC data
O English corpus data
Homeland corpora

<> Stage 1:inter-generational comparison|
Stage 2: cross-variety comparison
Stage 3: diatopic comparison

Stage 4: Check English

Qgeland B

Homeland

variety
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Ethnic Orientation Questionnaire

€ FF = -
A. Ethnic identity
1. Do you think of yourself as Italian, Canadian or Italian-Canadian?
2. Are most of your friends Italian?
3. Are people in your neighbourhood Italian?...
B. Language use
1. Do you speak Italian? How well? How often?
2. Where did you learn Italian? At home? In school?
3. Do you prefer to speak Italian or English?
4. Do you prefer to read and write in Italian or English? ...
C. Family language choice
1. What language does your family speak when you get together?
2. What language do your parents prefer to speak?
D. Cultural heritage
E. Media preference
F. Discrimination experience

Adapted from Keefe & Padilla
1987, Hoffman & Walker 2010
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Comparative Variationist Analysis

1. Compare rates of variant use across groups
2. Compare constraint effects across groups

Analysis by
undergraduate and
graduate students and a
team of collaborating
colleagues:

« Yoonjung Kang
* Alexei Kochetov
* James Walker
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Introducing ELAN
for Sociolinguistics

( recoro ] [ 7ranscrise ] [ extractacooe | [ anavze
R

=————=) FLAN ") [LAN === Concordance (as .txt)

Basic fre tat:
) asic frequency stats
‘1

Export to other
F1M23A.eaf F1M23A _varl.eaf
F1M23A var2.eaf

FIM23A_var3.eaf
Some other program

' ' Some other program

%Wﬂ

@ e F1M23A_varl.xls

FIM23A.wav

FIM23A.doc;

FIM23A. txt, etc.
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Pustovalova (2011:22), English (Nagy et al. (2010)

Heritage: Hollett (2011:60), Homeland:

11/8/12

Cross- varlety comparlson

Factor groups Homeland Generation 1 Generation 2 English

Subject same: same: Ll pA(V same (but
continuity switch: switch: switch: 42 (1]
sg. .
Person & 3: 43 3: not sig.
Number 2: 62 2:67
1: 38 Ly 1:40
conjoined: conjoined: 72 conjoined: 71 | ST EL R

Clause type subord.: 4 main >
main: (subord. 0%)

neg.: neg.: 67
affirm.: 47

neuter: neuter: 84
none: none: 48

Negation

Gender (grm.)
masc.:

older>younger  older >younger  [Older=younger

male > female n.s. male > female examingd or
expected)

Helpful links

¢ Download ELAN & get the manual:

o http://tla.mpi.nl/tools/tla-tools/elan/

* More info and instructions I've created:

o http://projects.chass.utoronto.ca/ngn/
HLVC > Software

¢ Coding & analysis assignment with step-by-step

instructions:
ohttp://individual.utoronto.ca/ngn/LIN/
courses/LIN351/LIN35]1 project.htm

* Download Goldvarb:

o http://individual.utoronto.ca/
tagliamonte/goldvarb.htm
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4.2.22. Exporting a document to Shoebox
4.2.23. Exporting a document to Toolbox (UTF-8)
4.2.24. Exporting a document as a tab-delimited text file
4.2.25. Exporting Tiger XML

4.2.26. Exporting CHAT files

4.2.27. Exporting traditional transcript files
4.2.28. Exporting a

4.2.29. Exporting an alphabetical list of words
4.2.30. Exporting a part of a clip

4.2.31. Exporting a SMIL clip

4.2.32. Exporting to QuickTime Text

4.2.33. Exporting to Subtitle Text

4.2.34. Exporting ELAN’s document view
4.2.35. Exporting to interlinear text

4.2.36. Exporting to HTML

N . ) (straight from the
4.2.37. Exporting to a Filmstrip Image

5 ) y ELAN manual)
4.2.38. Exporting Multiple Files
4.2.39.
4.2.40.
11/8/12 HLVC&ELAN Naomi Nagy 2
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Concordance (as . txt) Searching

© 00 5005 LRRH.: ot |
(soJ 1 | 1 the e
i CTRL + F is very powerful
asi 1 ioixi yp
bosch 1 o
caminando 1 Statistics 6.1.1. Advanced searching: an example
chica 1 | Annotations | Annotations Il | Tiers | Linguistic Type | Participant | Annotator
e 1 Tiers Suppose we are investigating turn taking
hay 2 Select Tier:  |K-Spch | v and we want to find all switches from
o 1 o e e ‘ | sp.eaker W to speaker K that don’t overlap,
por 1 with gaps of at most 2 seconds. In order to
! Count contiguous annotations with the same value as 1 1 N 3 L
pueblo 1 find this, we fill in the search form as
Use media duration as observation period
un 2 follow:
una 1 Statistics Variables
Annotation | Occurrences | Frequency werage Dura.. Time Ratio Latency
ia 3 0.08291873...[0.41333333... [0.03427307... 10.06
rotunda 1 0.02763957... 0.9 0.02653399... 27.03
so from here. |1 0.02763957... 0.97 0.02681039... 0.28
i there is anot._ 1 02763957... 1.04 0.02874516... 2283
View > yeah 1 0.02763957... 0.36 0.00995024... 14.04
Annotation Statistics
& click on “Save”
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Search Results Basic statistics about
A words, durations, pauses, speakers, transcribers...

File Edit Query Help

a = 1> Repla
N1 RN L T ¥ K7 can be saved as . txt
FIND
Annetation Satistics
An annotation on tier | Main Speaker 3| that matches \sgo5 V] e meeason Statistics
and [is inside interval [ . o [T s] O cssosensave Annotations  Annotations Il Tiers _Linguistic Type _Partcipant _ Annotator
Tiers
(" had constraint ) SelectTier: [ S2M28A % Show only root tiers
Statistics Variables
e —— seginTime.—|End Time | Duration Armeren e M Ot Dt s Dt Ve s Tl rnt. vt O ey
1 A4 Ngo5 dei6 gaa lingd le1, ngo5 zi6 gei5, ngo5 taaid  00:00:20480 00:00:33.730 00:00:13.250 Fay ura chica . 1 173 173 173 173 173 0513 048
2 AB, 19 Ngo6 dai6 jat1 bun1 lei6 ga1-laad-daaié gos5 zan6 00:00:37.900 00:00:49.890 00:00:11.990 o My o= X L i 1 e e 034 g
3 A19 jant wai6 ngoS ah jed gos zanG sid le1, keois dei6 _ 00:01:05.890 00:01:16.120 00:00:10.230
P 40,505 zanG sid dout hab sap6 [i6 58013, gams uh 6,580 00:01:21460 00:00:04.680
5 gams ah hais mun6-dei6-ho5 gos zan sid leT dout hai6 00:01:29.460 00:01:35.520 00:00:06.060 =) (e
6 keoi dei hai goS dous dou zyu6 205 sengd gei5 jaa6 00:01:35.780 00:01:40.700 00:00:04.920 e ) (S
7 M hai6. ah, ah je4 tungd ah ji4 gos zan6 si4 hais o 00:01:66.200 00:00:06.650
8 Gams ngoS a1, jat1 gaus baat3 i nind ah, ngos dei6 00:02:04.120 00:00:07.430
9 A15 Oh! GamS ngoS jat1 gaus baat3 i6 nind gos zan6 00:02:36.500 00:00:19.510
10 Gams ngoS go zan6 sid dou1 bei2 go3 ji3 ging keoi5 00:02:49.500 00:00:12.320
11 A21 NgoS dei6 ji4 man6 go3 leid goS zans si4 ngo5 00:03:05.490 00:00:02:270
12 lad, saam1 seoi3 go5 zan6 sid le1 ngo5 zan1 hai6 jat1 00:03:09.630 00:00:04.130
13 deoid naos lei4 aona hai iat1 003 hou2 sik haot aod 00:03:21.780_00:00:04.030 ¥
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Getting going in ELAN
ggoingt only the 1 time you run Navigating around in ELAN

1. Start ELAN. ELAN on your compyter
2. “Open” your file from the “File” menu (or choose “New” from the “File” menu).
3. Select the .wav file you wantto ibe if

2 00se “AUTO BACKUP > 1 minute” from the File menu.

5. Edit>Preferences>Edit Preferences > Editing > ¥ Enter key commits change in the inline box.
(This lets you save an annotation just by hitting Enter before you leave the annotati 9
6. Immediately save your-fite=

7. Inthe Edit menu, choose “Linked files,” (unless you already specified the sound file to use). — Clicking on an annotation in “Grid” or “Text” will take you to that part
Select the .wav file for this speaker.

* Moving around

— Annotations are like “bookmarks” to help see where you are in the
transcription and for doing text searches.

of the wave.
8. You should now see a soundwave in the center of the .eaf window. ) .
a) I you don’t, Command-Click (88 +Mouse click) on the place where the soundwave — Youmay find the Shortcut Keys (section 7.2. of the ELAN manual)
should be (it will be showing as a flat horizontal line) and then choose a big helpful.
number to magnify/Vertical Zoom in by.
b) Ifitis still too quiet to hear quickly, use the “Amplify” function to edit the .wav in
Audacity.
9.  Test volume. (& menu > System Preferences > Sound > Output or the 4 icon on the upper
right of your monitor.)
10.  In the Controls tab, adjust the speed (slider in the bottom right corner).
11.  Switch to the Grid or Text tab and select the relevant tier from the pull-down menu.
12.  You are ready to (transcribe or) extract and code tokens.
11/8/12 HLVC&ELAN Naomi Nagy 29 11/8/12 HLVCRELAN Naomi Nagy 30
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Time-aligned Transcription

ELAN - F1F38A_FW.eaf

Top window with “Text” selected

File Edit Annotation Tier Type Search View Options Window Help EBe. Edk,_ Annolation et lew... Options... Window....Help
[ \ les  Audio Recognizer Metadata  Controls
Grid | Tkt Subtities _Audio Recognizer _Metadata _Controls
speaker s
FLFS8A ) ke o - ke 1 po ik Jundo loz nfan - do do dokanta a mofofikct - d I ma:kana - 1 Bifikdct o
ko - it pa-gore - i ks - e d3okundo oz man - G0 do dokanta 18 kaz - na oWt - d1a mackans - a DAL - St S0
oyl Annotation Begin Time_| End Time Ouration ka5 ando formé ko ne travorsa: la vi - los nfa:no la bitfikicte - @ 5anon:e - ku tuto kwant - ala erio | crie | enia @ a crio po ndjok la kaz - crie pa ingjok ka)
" st 00:00:04.068 00:00:04.602 00:00:00.534 Kaz - Iy ok et lu fairamen - befiklet otk [7]ut ot fwoz [7)val - sctalan dafa - setelult - kasremel - kamndi - kasrame! - karmel 0 sunt - Sum bai
2 mun baij o ma mow 00:00:05.148 00:00.06.600 000001452 {tndo o dplaa po 11 tinde - 1 naots s - nonoet - mpiborddeino - ap
3 anjatun kwatra e un filjct 00:00:07.913 00:00:09.785 00:00:01.872 borBdej - WLISEN A0 - A: 1010 o8 nfan - G50 5 kunt - vun dO Yl Kat SYke fi SC1 Vit NUS disi UNZ - duZ - @ Scte UM baij - Padoieves - poi anjatla
4 e ananfan 00:00:10.692 00:00:11.970 00:00:01.278 * pegors -_anjat diat - diat- unikeetie - ebo - sctike
5 untineunait 00:00:42630 00:00:14.172 000001542 ¥ ke 50 vao 50 irGoso T 5are] - o Iviyo po doso - va bun akus - @ bast .
00002210 Soacton: 0000,00.000 -08,0000,000 0 i Sucton001337.300-00:1340818 3428
I E - e[ o] [Ps[s k] [e[=T0]# OINKEDRECCICINEEE

=l Senctonoce () Looo e *

: ey % 001336000 001337000 001338000 001339000 001340000 001341000 001342000 O

000005000 000006000 001

e e A bt

=7 7 Ty L IO LI PR LI - ! o

0:0005000 000006000 000 o cotahe oo L sy ooo SIS
sis my father and my mother, "000)

0'13.99.001 1340000 1341000 001342000 0]
getoun — 1 |
oot = 1 1 [
s v mun bal e ma mow aeta oo ki ore sl g0 v g0 ol s wmcgepecoso |I)
soridal | g strceg ¢ rec 5
WVer-English Sowho is it? rm. n-np;\‘ o 2 3 ' ¢
i . 0 b D .
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66 99
Top window with “Controls
selected Coding & Extracting
(instead of “Grid”)
fle €t Amotaton Tir Type Seuch View Options Window el « Linguistic and stylistic factors can be coded
G- T Sebies - A Rocopize - bt ! ) > ) FIF38A
directly in ELAN, each on their own tier.
Voume
0  Exportable data file for analysis F1F38A-English
. : * m « Advantages: (pro-drop)
% — See all the context you need, and hear it, subject
o 10 2 as you code each factor. number
WKW RTH]S [P (3515 [k) [eTal11] Osmmmin Oimin — From ELAN, create a .txt file for Ver
= multivariate analysis using R or Goldvarb IVer-English
R e, ool oo pranes wotleon woin or...
FIM32A
- '*' m mpr "‘” ""'m"’” — Can (repeatedly) revise codes in ELAN and F1IM32A-English
dodeeonn dodulonmn dodulainh dodedains dodudeins doie quickly recreate the data file.
=3 style
e | e |
1 1
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One tier for each variable Export the data for
Goldvarb analysis
FIE7SA P
File Edit Annotation Tier Type Search View Options Window Help o Dependencie £ tab-delimited text
A Toxt Subtites  Audio Recopmizer Wetadsa  Controls W gutaue | EXpOrtter() as tab-delimited text
4 [espoaken e £ File menu sau
>N Annousion Speaker-mstaion | speaker-vansiaton E R —
B 216 Bkt s O v boy Goas e bybicyce | L_‘: rodrop) >Export As... M e [
P boi s o parson M i
v et 5 e :
n seaker2
221 s bl sumbai o la o fRpR—— psakar 2 wansiaten ]
222 e lala pegore k i Aeste anda deri and the the sheep that it went behind Ner ST
IR IR LI I CN AR B S e Nl st [ top ! .
. Ad master mediatm offet 0 amntation s Export settings
e
:10:59000 | 001100000 004101000 00 o 001105000 001106000 | 001107000  00: ) Repeat valuss of annotations spanning other amnotatons
-~ 3 iy vpee i annormion irareie
e T e
01050000 | 004100 00:11:01.000 "‘ozm 001103000 00:11:04000 w‘ubéuuu nn‘u‘oqn'rm 00:11:07.000 "nn & bgin Time @ himnssms
o | | } | T [
10 dnge dil ot eisrese ) owation o
|is boy goes+ref. by bicycle. and thers behind, behind the bus. e comes afer the bus. ) SMPTE Timecode thhimm:ss:ff)
et =
s s
oK ) (Close )
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(Almost) Ready for ’varbing (Unsorted) coding file

Begin F1F75A F1F75A - (prodrop) grm. clause
* File > Export as... > Tab delimited Text. Make L Eaanslation ESXSCH) IEVES
sure the filename specifies the speaker and TOT5-SlsT watra i Fata Ta[Ehis boy goes | TeFTeX. |3 magn
. w ” Im bitfiklet Hrefl. by
endsin “txt bicycie.
TT70T.9 Ta dinge dingje lapnd there
* Select all the tiers that have relevant labels or jorize o
s . TI:05.81 ven apre a la e comes after weak 3 ™
transcriptions in them. v he bus
T1:08.7 e Jet ike [and this here
* Select: V Separate column for each tier TTros 8 sum
TI:11.3[sum biaran sum bai [the

* Saveasa.txt file. forse e la fa da  |grandfather,

lthe father,

* Openthe.txt filein Excel (use Import, skip 2P e
directly to “Finish.”) e i wn | sy s 15

ent behind
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(Sorted) Coding File
= grm.

person

Goldvarbity it in Excel

0 exp m (pro- grm. clause
+ dro; erson type
B B et Do th 3 m Pllperecn tYP
Do o 12 12 S iae sable (Ocm anj at la at:  FIF75A
TI88[ks 5 ands fermd [that has b 3 m
R e e e e e refl 4 rel. . (b3m o set i Aeste ke se fetfe .. FIFTS5
i e, 3 +
clause (rd4r ke s ande fermd ke ne tlraversa! la vi F1F75
759551 Fwatra ST Ts boy goestrerl. r 3 m
e tan . piesere o reflex. 3 main (r3m si kwatra si fata la m bitfiklet F1F75
Ibitfiklee 5 3 W
T e T T | SEFONG 3 m (s3m set e lu stopls  F1F75
T e e | strong F 3 m
lasarize refl
3 T
3 m
e e e = 3 m
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Using an Excel formula to create Other good things to learn to use
GV-ready tokens | ITwEts . . . .
y formula in a « Vertical zoom & horizontal zoom in the .wav window (Control
blank cell in + CliCk)
the row of

« Navigate with “Grid” and “Text” (choose relevant tier from
pull-down menu)

your first
token.

« Control speed and volume of playback in “Controls”

c D E F G H 1
Newscaster word  (ING) P.O.S. # sylls. social co ="("&E2&F28G2&H28" "&D2&" "&C2 o 4
tell us about the terrifying experienciterrifying g a 4 m3m (gadM3M _terrifying tell us about the terrifying Loop mode” for playbaCk
Telly, how are you doing today? foing v 2M3M  (nw2M3M doing Telly, how are you doing toda) . “ ” .
and how's your son doing? doing g v 2M3M  (gvaM3M doing and how's your son doing?  List of “shortcuts” from the View menu (key combos)
(Thanks) so much for talking to us _talking g v 2 MM (gv2M3M talking (Thanks) so much for talking

* Change order of tiers
« Delete annotation (select it, Option+D)
* Change size of annotation (select it, then Option+Drag edge

3. Make sure that the formula is
referring to the correct rows and

2. Use Fill

cells in your spreadsheet. Down (from ith
4. Copy only that column to a :he Edlt"tntenul)l wi mouse)
new Tkn file in Goldvarb. ° :ﬁs‘;'the"ra * Templates to set up tiers for many files
11/8/12 HLVC&ELAN Naomi Nagy tokens’ rows 41 11/8/12 HLVC&ELAN Naomi Nagy 2
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Create spiffy WWW examples

e :. 0
CuPED - .é

Customizable Presentation of ELAN Documents

Users’ Manual
Draft - February 2010

For CuPED version 0.3.14
http://sweet.artsrn.ualberta.ca/cdcox/cuped/

11/8/12 HLVCEELAN Naomi Nagy 3

More about ELAN

http://tla.mpi.nl/tools/tla-tools/elan/

You can add an unlimited number of annotations to audio and/or video streams.
— An annotation can be a sentence, word or gloss, a comment, translation or a description of any
feature observed in the media.
— Annotations can be created on multiple layers, called tiers.
— Tiers can be hierarchically interconnected.
An annotation can either be time-aligned to the media or it can refer to other
existing annotations.
The textual content of annotations is always in Unicode and the transcription is
stored in an XML format.
ELAN provides several different views of the annotations, each view is connected
and synchronized to the media.
ELAN delegates media playback to an existing media framework, like Windows
Media Player, QuickTime or JMF (Java Media Framework). As a result a wide
variety of audio and video formats is supported and high performance media
playback can be achieved.
ELAN is written in the Java programming language and the sources are available

for non-commercial use. It runs on Windows, Mac OS X and Linux.
11/8/12 HLVC&ELAN Naomi Nagy 45
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CuPED turns an .eaf into .html

Scrolls and highlights
each line of text as it
plays

11/8/12 HLVCRELAN Naomi Nagy a4
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